Upgrading to Act! V22 from ACT! Versions 2005 (7.x) and Later
Important Note
Review system requirements at www.act.com/systreq. You must purchase one license of Act! per user. Scalability varies based on hardware, size, and usage of your database. Visit the Act! Marketplace or contact your add-on product provider to determine compatibility for your add-on products.

This material may not, in whole or in part, be copied, photocopied, reproduced, translated, or reduced to any electronic medium or computer-readable form without prior consent in writing from Swiftpage ACT! LLC, 8800 N. Gainey Center Drive, Suite 200, Scottsdale, Arizona 85258 ATTN: Legal Department.

ALL EXAMPLES WITH NAMES, COMPANY NAMES, OR COMPANIES THAT APPEAR IN THIS MANUAL ARE FICTIONAL AND DO NOT REFER TO OR PORTRAY IN NAME OR SUBSTANCE ANY ACTUAL NAMES, COMPANIES, ENTITIES, OR INSTITUTIONS. ANY RESEMBLANCE TO ANY REAL PERSON, COMPANY, ENTITY, OR INSTITUTION IS PURELY COINCIDENTAL.

Every effort has been made to ensure the accuracy of this material. However, Swiftpage ACT! LLC makes no warranties with respect to this documentation and disclaims any implied warranties of merchantability and fitness for a particular purpose. Swiftpage ACT! LLC shall not be liable for any errors or for incidental or consequential damages in connection with the furnishing, performance, or use of this material or the examples herein. The information in this material is subject to change without notice.

End User License Agreement
This product is protected by an End User License Agreement. To view the agreement, go to the Help menu in the product, click About Act!, and then click the View End User License Agreement link.

Published by
Swiftpage ACT! LLC
621 17th Street, Suite 500
Denver, CO 80293
10987654321
## Contents

**Introduction** ........................................................................................................... i
- Who Should Use This Guide? .......................................................................................... i
- About This Guide ........................................................................................................... i
- Who Can Install This Upgrade? ..................................................................................... ii
- What You Should Know Before Upgrading ................................................................... ii
- Upgrade Checklist ......................................................................................................... vi

**Installing Act!** .............................................................................................................. 1
- Required Components .................................................................................................... 1
- Other Considerations ..................................................................................................... 1
- Preparing to Install ......................................................................................................... 1
- Installing Act! .................................................................................................................. 3
- Registering and Activating Act! ..................................................................................... 4

**Installing Other Applications** .................................................................................... 6
- Act! Synchronization Services ........................................................................................ 6
Introduction

Act! helps organize all your prospect and customer details in one place so you can prioritize your day and market your products and services more effectively, driving sales results while creating customers for life.

Who Should Use This Guide?

You should use this guide if you have any version of ACT!, ACT! by Sage, Sage ACT!, or Act! Pro, or Web later than 2004 (6.x). To determine the version of the product you are using, check the version number (from the Help menu, select About).

If you do not have one of the previous versions installed, then DO NOT USE this guide. Instead, see the appropriate guide:

<table>
<thead>
<tr>
<th>If your current version is...</th>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>I do not have any version of Act! installed. I am a “New User.”</td>
<td>Use the Installing Act! for New Users guide to install, register, and activate Act!.</td>
</tr>
<tr>
<td>I have ACT! 2005 (7.x) or 2006 (8.x) installed. My installation may or may not include the web.</td>
<td>Contact Act! Technical Support. Upgrade assistance is required due to Microsoft obsolescence policies.</td>
</tr>
</tbody>
</table>

The guides are available on the installation panel under Product Documentation. Adobe® Reader® is required to access and view product documentation.

About This Guide

This guide explains how to upgrade Act!.

Act! includes access via Windows® (desktop) and web. If you are installing access for users via the web, then you will need this guide and the Act! Web Administrator’s Guide to complete installation and configuration. The Web Administrator’s Guide is available on the web product’s installation panel under Product Documentation. You can browse the installation files directory for the guide as well. We recommend that you read the Web Administrator’s Guide before installing the web version.

Features exclusive to Act! or Act! (Web) are noted in the guide. In most sections, we refer to all versions as Act!.
Who Can Install This Upgrade?

You can install this upgrade if:

- You are a single user with an Act! database on your computer and that database is Microsoft® SQL Server® 2005 Express, or later. Earlier SQL Server databases may not upgrade due to Microsoft obsolescence policies. Review all Act! installation messages for details.
- You are one of several users accessing the same database and that database is not on your computer. Use this document to apply the upgrade to every computer that accesses Act!, including the computer hosting the database. Make sure all users are upgraded at the same time to prevent issues accessing the database.
- You are an ACT! for Web, ACT! by Sage for Web, Sage ACT! (Web), or ACT! (Web) user.

To upgrade your current web product, you need this guide and the Act! Web Administrator's Guide to complete installation and configuration. The Web Administrator's Guide is available as a PDF on the installation panel under Product Documentation.

What You Should Know Before Upgrading

Before upgrading, you should understand:

- Upgrade considerations and recommendations.
- Database synchronization recommendations.
- Items that do not upgrade.

Be sure to read the entire upgrading document before beginning the upgrade.

Database Upgrade Considerations and Recommendations

The upgrade process involves upgrading an existing database. Review the following considerations and recommendations before you upgrade.

The database upgrade process overwrites the earlier version database. It is important to have a backup copy of the database in case you want to re-install the earlier version of the software. Back up the database before starting the upgrade process.

Who can upgrade a database? An Administrator or Manager user can upgrade a local database. An Administrator, Manager, or Standard user (if there is no active Administrator user) can upgrade a remote (Subscriber) synchronized database they belong to. See the section "Database Synchronization Requirements" for information about whether or not you can upgrade a remote database.

No upgrade required for database supplemental files. Database supplemental files, such as templates, reports, and layouts, do not need to be upgraded.

Database Synchronization Recommendations

Customers upgrading from ACT! by Sage 2010 (12.x) and later do not need to recreate their remote databases. You can upgrade a remote database after you install Act!. However, customers on versions earlier than ACT! by Sage 2010 (12.x) should follow these recommendations.

ACT! by Sage or ACT! by Sage 2007 (9.x), 2008 (10.x), or 2009 (11.x) customers. The database synchronization relationship is retained. However, because of opportunity data changes made in ACT! by Sage 2010, we recommend that you synchronize remote databases to one, main (Publisher) database before upgrading. Then, you upgrade the main database and create new remote databases. The new opportunity data changes will synchronize.

You can create up to 50 remote databases at one time.
Items That Do Not Upgrade

Note the following items that do not upgrade.

**Menu/toolbar and column customizations.** Customizations are lost. You must redo your menu/toolbar and column customizations. See the Help for information about menus and toolbars you can customize.

**Welcome Page customizations.** If an Act! Certified Consultant* customized the Welcome Page in ACT! by Sage 2010 or ACT! by Sage 2010 for you, these customizations are lost when you upgrade.

**Database synchronization Accept Incoming Syncs ON setting.** The ON setting for Accept Incoming Syncs is disabled for customers upgrading from ACT! by Sage 2007 (9.x) and later versions. You must turn database synchronization ON (Tools > Synchronize Database > Accept Incoming Syncs). The port number is retained.

**Act! Synchronization Services (Network and Internet Synchronization Services).** You must uninstall earlier versions of the Sync services, and then install the latest version. To uninstall a Sync service, use Control Panel>Add/Remove Programs. To install the new versions, see “Installing Other Applications” on page 6.

*Certified Consultants are third-party vendors. Swiftpage ACT! and its affiliates are in no way liable or responsible for claims made related to the services provided by third-party vendors.

Upgrade Changes That May Affect Where Your Data Appears

The following sections provide an overview of some of the significant changes in recent releases. For more information about new and improved features for other releases, see the [www.act.com/knowledgebase](http://www.act.com/knowledgebase).

**Act! v22**

Act! v22 uses product innovation to increase adoption, improve user experience and add subscriber value.

- All-New Customer Console
- User Experience and Navigation Improvements
- Act! Insight Updates
- Custom Tables Enhancements
- Marketing Automation

**Key highlights of this release:**

**All-New Customer Console:**

- Evolving from a personalized dashboard to a user's hub & navigation console for all things Act! emphasizing personalization & enhancing productivity
- All-new customer console & hub for key information driving actionable insight
- New out-of-the-box content giving users ability to see upcoming tasks, their pipeline & more
- Ability to personalize & tailor the experience to individual needs

**User Experience & Navigation Improvements**

- Updated Marketing Automation navigation
- New design and layout increases screen real estate and improves navigation

**Act! Insight Updates**

- Ability to drill-through to detailed information on custom created charts

**Custom Tables Enhancements**
• Create groups and advanced queries based on custom table data
• Use groups to power Marketing Automation campaigns
• Greatly enhances the flexibility of searches
• Load a saved query to easily recall a search
• Simplified process of creating and managing parent and child tables
• Setting a default layout is now easier, and is user specific
• Mail merge templates can now include today’s date

Marketing Automation
• New navigation menu design and layout
• New default scoring profile
  • Includes a new default ‘AMA Score’ field in Act!
  • Score data is populated with no configuration required by the user
• New Marketing Automation tab on contact records
  • Adds ability to quickly send a tracked email to the selected contact
  • Quickly add a contact into an existing campaign
  • View contextual score and campaign data without leaving the contact view
• A related Custom Tables improvement means that campaigns can now be powered by custom table data

Act! v21.1
Act! v21.1 provides the ultimate toolset to maximize engagement and drive business growth

Key highlights of this release:
Act! Insight with Marketing Automation:
New in v21.1 is an entirely new view built into Act! Insight, called Campaign Metrics. Within this new view, users will have access to insights driven from campaigns that will allow them to measure how their marketing efforts are impacting revenue and number of opportunities being generated from their prospecting. These new out-of-the-box charts will give them data about campaign engagement, number of opportunities generated from campaigns and revenue generated from campaigns.
  • Marketing Automation integration.
  • All-new out of the box Marketing view for AMA data.
  • Marketing automation filters & visualizations.
  • New demo data for AMA in Act! Insight.

Act! Marketing Automation – Asset Tracking
• Track interactions with marketing assets.
• Measure time spent and page visits of PDF documents
• Measure time spent viewing YouTube content.
• Perform A/B testing against different assets
• Implement lead capture forms
• Force sign-up to continue viewing
• View a rich campaign dashboard of interactions

Act! Marketing Automation – Purge Campaign data
• Allows AMA data from the Campaign Results to be purged.
• Results can be removed globally from the database based on a date
• Results can be removed from a specific record, improving support for GDPR.

Act! v21
Act! Marketing Automation:
This does require an active subscription to Act! Marketing Automation to surface.

Act! Marketing Automation is a new, fully featured marketing automation solution which makes it simple to acquire new leads, engage customers and prospects, and build long-lasting, profitable relationships. AMA replaces separate systems for email, web visitor tracking, lead scoring, nurture campaigns, campaign management and reporting with one solution that streamlines marketing processes and shares data with sales.

- Fully featured solution with three progressively powerful service levels.
- Comprehensive email marketing, from basic blasts to drip and full nurture campaigns.
- Lead capture and surveys.
- Graphical workflow – add decisions and actions based on interactions and responses.
- Lead management and scoring.
- Website and asset tracking and analytics.
- CRM embedding and workflow
- Onboarding and consultancy services.

**Act! Marketing Automation FAQs**

**Opportunities Enhancements:**

**List View:**
New in v21 is a refreshed take on how users interact and work within their Opportunity views. New to the list view are exciting new features, such as KPIs at the top of the list that will contextually display information from in the list, and the addition of the all-new contextual menu, which will now display the opportunity filters (same filters from prior versions, just new UI).

**Pipeline:**
New in v21 is a new look at how to interact and work with your sales pipeline. Act! now has a dynamic sales pipeline feature that will allow users to see how their deals break out into each stage of a sales process, and move deals through that sales process with an all-new drag & drop sales Kanban board.

**Outlook Integration:**

**Attach Inbound Emails:**
Previous Act! functionality allowed history to be automatically recorded from emails received to Microsoft Outlook. This functionality was lost from Outlook versions 2013 onwards due the Custom Actions feature being removed from email rules. This functionality has now been re-implemented using and updated email attachment mechanism.

**Activity Invitations:**
As part of the Outlook Integration improvements in the prior Act! v20.1 release, we moved the majority of our functionality away from the older redemption.dll technology. The process of sending activity invitations from Act! was one process which remaining on this older technology. This has been upgraded in Act! v21.

**Act! v20.1**

**Act! Insight:**
Act! Insight dashboards now include rich customization capabilities, so you can pull in data from all Act! entities, reporting-based fields, and custom fields, making it easier to measure business and team performance. Even drill through to Act! list views from dashboards.

- As a user, you are able to personalize dashboards or fully customize Act! Insight to display metrics most relevant to you.
- Customization is a brand-new component to the Act! Insight view.
- You are able to create custom Insight charts and report on supported Act! entities and fields, in addition custom field support has been added for reporting on custom built fields in Act!
Furthermore, the ability to filter on custom charts has also been added for this version.

Existing Dashboards are hidden by default. To unhide click Options and select Dashboard

Act! Insight is a subscriber benefit, available to all on an active subscription.

**Contact and Calendar Synchronization:**
Seamlessly interact with Outlook® to extend your connected workspace via next generation Microsoft® Office integration for Act!. Sync for Outlook® contacts and calendar details leverage modern new engine technology to drive superior sync performance and enhance duplicate checking.

- New synchronization functionality
- Solid performance with latest Office builds
- Addresses duplication issues
- Provides full contact and calendar sync with Outlook, Office 365, Exchange and Google
- Closely retains the current setup experience
- New 1-way sync options, and directional options for Google sync

**Act! v20**

**Act! Insight:** New Act! Insight module introduces new and exciting dashboard and reporting functions for Act! users

Provides valuable insight to customers across a range of performance, financial and operational metrics.

- Act! Insight module accessible via a new navigation bar option
- Introduces new out of the box dashboards, along with the new ‘Key Insight’ metrics showing businesses what they need to know to operate their business
- Personalize and configure the dashboard layout, appearance and filters through the all new contextual menu
- Existing Dashboards are hidden by default. To unhide click Options and select Dashboard

**New opportunity field – Days in Stage**
Provides additional insight into how opportunities are being managed, allowing you make process improvements or to quickly see deals needing attention

- New field ‘Days in Stage’ is available on opportunity layouts for new databases.
- The field can be manually added to opportunity layouts or list views for upgraded databases
- Shows the number of days a specific opportunity has been in its current stage.

**Close opportunities from the List View**
Increases list view usability by expanding on frequently used options

- New right-click/context menu option on the Opportunity List for ‘Edit Opportunity Status’
- Allows opportunities to be opened, closed or marked inactive directly from the list view.

**‘Share With’ and ‘Contacts’ columns removed from Notes and History tabs**
Ensure the most relevant data is displayed by default for users

- The ‘Share With’ and ‘Contacts’ columns no longer appear by default on the Notes or Histories tabs.
- These columns were found to be confusing for new Act! users, and were commonly manually removed from views.
- The columns are available to be re-added if required.

**Upgrade Checklist**
The following checklist outlines the tasks needed to upgrade Act!
<table>
<thead>
<tr>
<th>Task</th>
<th>Page #</th>
</tr>
</thead>
<tbody>
<tr>
<td>Understand what happens during the upgrade process.</td>
<td>ii</td>
</tr>
<tr>
<td>Prepare to install. <strong>Important:</strong> If your installation includes access via the web, be sure to complete both sets of steps.</td>
<td>1</td>
</tr>
<tr>
<td>Install, register, and activate Act! (Web).</td>
<td>3</td>
</tr>
<tr>
<td>Upgrade the database. <strong>Important:</strong> Ensure the database remained shared. If not, share it.</td>
<td>4</td>
</tr>
<tr>
<td>Install Act! Sync Services. <strong>Note:</strong> If you used previous versions of Act! Sync Services, you must uninstall them and install the current version.</td>
<td>6</td>
</tr>
<tr>
<td>See the Act! Web Administrator's Guide to configure access via the web.</td>
<td></td>
</tr>
</tbody>
</table>
Installing Act!

The following sections explain the required components, other considerations, and how to:

- Prepare to install.
- Install Act!.
- Register and activate the software.
- Upgrade your database.

Several final sections explain upgrade changes that may affect where your data appears and other information you may need to know.

**Required Components**

To install and function correctly, Act! requires the following components:

- Windows® Installer
- .NET Framework
- Microsoft® SQL Server®

Check [www.act.com/systreq](http://www.act.com/systreq) or [www.act.com/knowledgebase](http://www.act.com/knowledgebase) for required versions of the above.

If you do not have a required component or correct version of it, it is installed for you or you will be guided in obtaining it.

**NOTE:** You can choose not to install SQL Server Express locally if users will be connecting to a shared Act! database with SQL Server. However, SQL Server Express must be installed on the computer hosting the shared database. For Act! (Web) users, SQL Server Express must be installed on the database server or web server, depending on your configuration. See the *Act! Web Administrator’s Guide*.

**Other Considerations**

**Other add-on products.** Some applications added as plug-ins or add-on products in earlier versions may not upgrade. These applications may require re-installation after installing the software. Visit the [Marketplace](http://www.act.com/marketplace) or contact your add-on product provider to determine compatibility.

**Microsoft Outlook®, Word, and Excel® integration.** Act! integrates with Microsoft Outlook, Word, and Excel. (For compatible versions, see System Requirements at [www.act.com/systreq](http://www.act.com/systreq).) If you plan to use the integration features, ensure the Microsoft software is installed and working correctly before installing Act!. You must set up an Outlook profile. To configure and set up integration for Act! users after installation, see “About Microsoft Outlook Integration” in Help. To configure and set up integration for Act! (Web) users, see the *Act! Web Administrator’s Guide*.

**Preparing to Install**

Before installation, complete these steps in the order presented. If you plan to install Act! (Web), you must also complete the second set of steps.

**Prepare to install**

1. Ensure your computer (or all computers in a shared environment) meet the minimum recommended system requirements for your purchased product and operating system. Also, verify you meet the concurrent user limits and licenses. See system requirements at: [www.act.com/systreq](http://www.act.com/systreq).
2. Ensure you are current with Microsoft critical and recommended updates.
3. Restart all computers to free available resources before you install.
4. Sign on to all computers as a Microsoft Windows Administrator. If you do not, installation may fail.
5. (Recommended) Disable any software-based firewalls. You can enable these after installation.
6. Act! integrates with versions of Microsoft Outlook, Word and Excel. For compatible versions, see www.act.com/systreq. Ensure the Microsoft software is installed and working correctly before installing Act!. You must have an Outlook profile configured for Outlook integration setup.
7. **Customers on ACT! by Sage 2009 (11.x) only:** Synchronize remote databases to one, main database. After you install and upgrade the database, you can create new remote databases.
8. Open your current Act! version and perform database maintenance. On the **Tools menu, click Database Maintenance.**

**Prepare to install or upgrade to Act! (Web)**

1. Act! requires that Microsoft Internet Information Services (IIS) and ASP.NET run in 32-bit compatibility mode. If you use 64-bit versions of these applications and do not want the installer to switch them to 32-bit mode, see the solution under "General Errors and Issues" in the "Troubleshooting Act! (Web)" section of the **Act! Web Administrator's Guide.** IIS 7 allows both 32-bit and 64-bit processes to run simultaneously.
2. See Microsoft documentation to help you plan your installation and prepare your web server. You need to understand your operating system, IIS, ASP.NET, and user permissions required to run a web page.
3. Install, or enable, the correct version of IIS for your operating system. Verify it runs properly. Some supported operating systems automatically install IIS, however, you may have to enable it.
4. Install ASP.NET or verify that ASP.NET impersonation authentication is enabled.
5. If you are using a firewall, enable an exception for World Wide Web services.
6. Give your web server a static IP address and make a note of it. You will need it later when you configure access.
7. Gather the virtual directory or virtual server names of other web sites hosted on your web server.
8. **Customers on earlier versions of Act! (Web):**
   a. Have web users log off the Act! database.
   b. Open Act! and use the Web Administration tool to remove the database from the web site. Once the database upgrade is complete, you can add the database back to the web site and reset IIS.
Installing Act!

IMPORTANT: If you are installing Act! (Web) in a multiple-server configuration, install the application on the database server (even though you will be running it from the web server). Installing on the database server creates the Microsoft SQL Server instance for Act!. You connect to the database from the web server. For upgrading customers, install Act! (Web) on the server with the earlier version.

Install Act! (all versions)

1. Close all open applications.
2. Do one of the following:
   - Complete the download process from the Act! web site.
   - Double-click the setup.exe file if you are installing from a network location.
3. On the main installation screen, click Install Act!.
4. On the Installation Requirements page, review the information. Click Install to continue.
5. If prompted, agree to install the required components. A restart may be necessary after installation.
   
   NOTE: If the installation does not automatically start after a required restart, click Setup.exe to continue.
6. On the Regional Version page, select the version to install. Click Next.
7. At the "...Earlier version detected and needs to be uninstalled" message, click Yes to continue.
8. On the License Agreement page, read the agreement, and then click Accept.
9. On the Type of Install page, Typical installation is selected by default. To change the default install settings, select Custom. Click Next.

   NOTE: With a Custom installation, you can select to install Act! without SQL Server Express. To do this, clear the Install SQL Server Express check box on the next page. IMPORTANT: If you do not install SQL Server Express, you cannot create or restore a database. However, you can connect to a shared database. Other custom options let you choose where to install Act! and SQL Server Express, select who can use Act!, specify icons for Quick Launch, and where to place Act! in the Start Menu.

10. When the Install Complete page appears, click Finish.
11. To close the installation panel, click Exit.

To open Act!: Double-click the Act! icon on the desktop. Or, on the Start menu, under Programs, point to the Act! program folder, and then click Act!. When the software opens, you are prompted to register and activate it. You can choose to register now or use the software for a trial period of 30 days. For more information about the trial period, see "About the Trial Period" in Help.
Registering and Activating Act!

You must register and activate Act! within 30 days of first use on each computer where it is installed. Registration and activation provides you with program updates and customer support options. A serial number is required to register. The serial number is emailed to you upon purchase. You can copy the serial number from the product activation email and paste it into the registration page.

Register and activate the software

1. On the Help menu, click Register Act!.
2. Select a activation option. Click Next.
   
   If you choose to Activate your licence online:
   3. Enter your contact information.
   4. Click Next.
   5. Enter your serial number.
   6. Click Next.
   7. Click Finish.

   If you choose to Activate your licence offline:
   8. Enter your serial number.
   9. The Computer Identifier field will automatically populate.
      
      The next step is to retrieve the Computer Key. Act! needs this key for activation. The only way to do this through Offline Activation is to call the phone number on the screen and manually activate with an Act! representative.
   10. Enter the Computer Key.
   11. Enter the key, click Next.

      The Act! representative will also email the customer with an important file, named “QlmProductProperties.xml.” The customer must place this file into their C:\ProgramData\Act folder.
   12. Click Finish.

Upgrading a Database

The following explains how to upgrade your database.

Upgrade a database

1. Open Act!.
   or
   If Act! is already open, when the logon screen appears, enter the user name and password for the database you want to upgrade. Go to step 4.
2. On the Welcome screen, ensure Open an existing Act! database is selected, and then click OK.
3. In the Open/Share Database dialog box, select the database. Click Open Database.
   
   If you do not see your database in the list, click Browse For Database to locate it.

   You can easily locate, open, and share a database using the Open/Share Database command on the File menu or the Welcome screen.

4. When prompted to back up the database before upgrading, click Yes.

   We recommend that you back up the database so that if you want to reinstall the earlier version of the software, the database backup copy can be restored in that version. The upgrade process overwrites your earlier version database, but does not affect the backup copy.
5. Follow the directions on any update and verification prompts that appear.
6. When the update process is complete, click **OK**.
7. (Optional) If the database was shared with others, click **File**, then **Open/Share Database** to ensure it remained shared. If it did not remain shared, click **Share**. To open the database, click **Open Database**.

**Featured Integrated Solutions**

- **Act! eMarketing.** Segment contacts, create and send targeted email campaigns, and prioritize hot leads all from within Act!.
- **Marketplace.** View additional services, some with trial periods or free levels, and links to integrated applications. On the left navigation bar, click Marketplace.
- **Microsoft Outlook and Office Integration.** You can integrate with Microsoft Outlook, Word, and Excel. You can synchronize your Outlook contacts and calendar with Act!.
- **Google® and Gmail® Integration.** You can integrate Act! with your Google contacts and calendar and record histories of emails sent or received from your Gmail account.

**Next Step(s)**

**Single Users:**
- Read the **Quick Start for New Users** guide or watch Featured Videos accessed from the Help menu.

**Act! (Web) Users:**
1. Assign the upgraded database to the web site and reset IIS.
2. Verify access for your web users and complete other configuration tasks. See the **Act! Web Administrator's Guide**.

**Workgroup Users:**
1. Read the **Quick Start for New Users** guide or watch Featured Videos accessed from the Help menu.
2. If you use a shared database, ensure all users install the same Act! version. Then, you can distribute a shortcut to the .PAD file for the database. (The .PAD file is pointer to the database. Users open a database from the .PAD file.)
3. Create new remote databases for database synchronization (not required for previous ACT! by Sage 2010 or later users). For more information, see "About Database Synchronization" in Help.
Installing Other Applications

This section explains how to install Act! Synchronization Services (available for Act! only).

**Act! Synchronization Services**

Act! offers two data synchronization services. These services let remote workgroup users, with their own Act! database, synchronize their data to the main workgroup database without Act! being opened and active. You can install one or both services depending on your needs. For more information about database synchronization, see Help.

**Act! Network Synchronization Service.** Lets you synchronize Act! databases over a network. This service can be used by remote users connected to the main database via a Local Area Network (LAN), Wide Area Network (WAN), or a Virtual Private Network (VPN). You can install the service on the same computer as Act! or on another computer.

**Act! Internet Synchronization Service.** Lets you synchronize Act! databases over the Internet. This service requires a computer (located outside the firewall) with ASP.NET and Microsoft Internet Information Services (IIS) installed (compatible with your operating system). See system requirements at: [www.act.com/systreq](http://www.act.com/systreq).

**NOTE:** Act! users can synchronize data between a main and remote database, but do not use the synchronization services. For Act! database synchronization, the Act! application must be open on the computer hosting it. For more information, see "About Database Synchronization" in Help.

**Installing Act! Synchronization Services**

The following explains how to install an Act! Synchronization service. You install one service at a time. After installation, you must configure it.

**IMPORTANT:** If you install the Act! Internet Synchronization Service on a computer that does not have Act! installed, ensure the <computer name>\ASPNET account has read/write permissions on the Internet Sync install folder. For more information, see Help.

**Install a Synchronization Service**

1. Open the installation panel, double-click the `setup.exe` file, or insert the installation DVD.
2. On the installation panel, click **Install Act! Synchronization Services**.
3. Click the link to install a synchronization service.
   
   If the required version of .NET Framework is not detected, it will be installed with the synchronization service components.
4. Follow the on-screen instructions. Click **Next** to advance. Click **Finish**.

**Next Step(s)**

1. Set up Synchronization Services. See one of the following topics in Help:
   
   - Setting Up and Managing the Internet Sync Service.
   - Setting Up and Managing the Network Sync Service.
2. Get started using Act!.